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Disclaimer 
The information in this manual has been carefully checked and is believed to be accurate. Eurotech Ltd assumes no 
responsibility for any infringements of patents or other rights of third parties, which may result from its use. 
Eurotech Ltd assumes no responsibility for any inaccuracies that may be contained in this document. Eurotech Ltd makes 
no commitment to update or keep current the information contained in this manual.  
Eurotech Ltd reserves the right to make improvements to this document and/or product at any time and without notice.  

Warranty 
This product is supplied with a 3 year limited warranty. The product warranty covers failure of any Eurotech Ltd 
manufactured product caused by manufacturing defects. The warranty on all third party manufactured products utilised by 
Eurotech Ltd is limited to 1 year. Eurotech Ltd will make all reasonable effort to repair the product or replace it with an 
identical variant. Eurotech Ltd reserves the right to replace the returned product with an alternative variant or an equivalent 
fit, form and functional product. Delivery charges will apply to all returned products. Please check www.eurotech-ltd.co.uk for 
information about Product Return Forms. 

Trademarks 
Windows XP and Windows XP Embedded, Windows Embedded Studio, Target Designer, Component Designer and Visual 
Studio are all trademarks of the Microsoft Corporation. 
All other trademarks and copyrights referred to are the property of their respective owners. 

Revision History 

Manual PCB Date Comments 

Issue A   v1ix 12th October 2007 First full release of manual.  

 
© 2007 Eurotech Ltd.  
For contact details, see page 46.

http://www.eurotech-ltd.co.uk/
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Important notice 
This Windows XP Embedded Development Kit is supplied with an Evaluation Version 
of the Windows XP Embedded operating system under the terms of the Windows 
Embedded Kitting Program. The Development Kit does not include a Certificate of 
Authenticity (COA) license label, which is no longer required. The use of the Evaluation 
Version of Windows XP Embedded is subject to your acceptance of the terms of the 
end user license agreement with Microsoft.  

The Windows XP Embedded operating system has been configured to run on the 
GEMINI processor. A copy of the operating system image is included on the 
Development Kit DVD and may be used to restore the image on the flash disk supplied 
with your GEMINI Development Kit. The operating system image on the DVD may also 
be used to create production copies of the supplied operating system.  

The Windows XP Embedded product may be used in your product under one of the 
following license options:  

• If you purchase boards or systems from Eurotech Ltd with the operating system 
pre-loaded onto a flash disk, Eurotech Ltd can supply Windows XP Embedded 
licenses. The Microsoft OEM Customer License Agreement signed by Eurotech Ltd 
states that we must supply the Windows XP Embedded software pre-installed onto 
our equipment or drives. The license label is attached to the flash disk module. 
Please contact Eurotech Ltd for information about license label costs. 

• If you intend to use the Windows XP Embedded operating system image supplied 
by Eurotech Ltd and purchase the Windows XP Embedded licenses directly from 
your local Microsoft distributor, you must sign an OEM Customer License 
Agreement, which is supplied by your Microsoft distributor. You are responsible for 
installing the operating system on the Eurotech Ltd product and applying the 
license label to your finished product. Contact your local Microsoft distributor for 
license label costs. 

• If you intend to build your own version of the operating system and then purchase 
Windows XP Embedded licenses, you must purchase a copy of the authoring tools 
Windows Embedded Studio (consisting of Target Designer and Component 
Designer) and sign an OEM Customer License Agreement. Windows Embedded 
Studio is only available from a Microsoft distributor, it is not supplied by Eurotech 
Ltd. Please contact your local Microsoft OEM distributor for price information and to 
obtain your OEM Customer License Agreement. On receipt of the signed OEM 
Customer License Agreement, Microsoft (or the distributor) will issue you with a 
PID number, which is an electronic key that allows you to create a specific 
operating system from your Target Designer tool set. You must buy licenses for 
Windows XP Embedded images you have created using Target Designer. You are 
responsible for installing the operating system onto the Eurotech Ltd product and 
applying the license label to your finished product.  

For more information about the End User License Agreement, see Appendix B - End 
User License Agreement (EULA), page 47. 
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Introduction 
This Windows XP Embedded Development Kit is designed to provide a complete 
environment and thus allow software engineers to concentrate on the development of 
their application. The remainder of this manual describes the Windows XP Embedded 
Development Kit. More information about the features available within Windows XP 
Embedded can be found on the Microsoft Windows Embedded Development Centre 
web site, at www.microsoft.com. 

This Development Kit supports Windows XP Embedded SP2 Feature Pack 2007, and 
Update Rollup 1.0 for Windows XP Embedded.  

http://www.microsoft.com/
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Handling your board safely 

Anti-static handling 
The boards in this Development Kit contain CMOS devices. These could be damaged 
in the event of static electricity being discharged through them. Please observe anti-
static precautions at all times when handling circuit boards. This includes storing 
boards in appropriate anti-static packaging and wearing an earthed wrist strap when 
handling them. 

Battery 
The board contains a Lithium non-rechargeable battery. Do not short-circuit the battery 
or place it on a metal surface where the battery terminals could be shorted.  

If the battery needs to be replaced, please ensure that the new part conforms to the 
same specification. 

Packaging 
Should a board need to be returned, please ensure that it is adequately packed, 
preferably in the original packing material. 

Electromagnetic Compatibility (EMC)  
The GEMINI is classified as a component with regard to the European Community 
EMC regulations. It is the user’s responsibility to ensure that systems using the board 
comply with the appropriate EMC standards. 
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About this manual 
This manual is designed to help you get your GEMINI up and running as quickly as 
possible. It explains the components of your GEMINI Development Kit and tells you 
how to unpack and connect the board. It also explains, amongst other things, the use 
of Windows XP Embedded with the board, and how you can transfer images to the 
board.  

Related documents 
The GEMINI Windows XP Embedded Development Kit includes a DVD with a copy of 
this manual and a copy of the GEMINI Technical Manual. Copies of any other manuals 
that may be referred to from time to time are also normally included on the DVD. 

Conventions 

Symbols 
The following symbols are used in this guide:  

Symbol Explanation 

 
Note - information that requires your attention. 

 
Tip - a handy hint that may provide a useful alternative 
or save time. 

 

Caution – proceeding with a course of action may 
damage your equipment or result in loss of data.  

 

Jumper fitted across pins 1 and 2. 

 

Jumper fitted across pins 2 and 3. 

 
Jumper is fitted. 

 
Jumper is not fitted. 
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Getting started 

What’s in the kit?  
The GEMINI Windows XP Embedded basic kit comprises the following items: 

• GEMINI processor board: 

- 2.16GHz Intel Core 2 Duo T7400 CPU. 

- 1024MB PC2-5300 DDR2 RAM.  

• Low profile 180W Flex ATX power supply (100V - 240V AC Input).  

• 2GB Intel USB Flash Disk module pre-loaded with Windows XP Embedded SP2. 

• US, UK or European power cord. 

• 2m RS-232 Null modem cable. 

• 2m CAT-5e cross-over Ethernet cable (suitable for Gigabit Ethernet). 

• GEMINI Windows XP Embedded Development Kit DVD. 

• GEMINI interface board for power control switch, reset button, activity indicators, 
and USB ports - supplied with interconnecting cables. 

The following items are also included with the flat panel kit: 

• AUO 15" Colour XGA 1024 x 768 pixel TFT flat panel display. 

• Backlight Inverter module (including 1m connecting cable). 

• 1m LVDS flat panel adapter cable for GEMINI. 

• 1m serial cable for touchscreen interface. 

• 15" 8 wire analogue touchscreen. 

• TSC1 touchscreen controller module. 
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What else do I need?  
• A USB or PS/2 keyboard. 

• A USB or PS/2 mouse.  

• A VGA monitor (if not using the flat panel kit).  

• A development system with the following: 

- Microsoft Windows 2000 Professional or Microsoft XP Professional. 

- DVD-ROM drive. 

If you intend to run Microsoft Windows Embedded Studio, your development system 
must also have the following: 

• 728MHz or higher processor. 

• 512MB of RAM minimum; 1GB or more recommended. 

• Microsoft Windows 2000 Professional with Service Pack 4 or later, or Windows XP 
Professional with Service Pack 1 or later. 

• CD-ROM or DVD-ROM drive. 

• 3GB of free disk space. 

• VGA or higher resolution monitor; 1024x768 display recommended. 

• Microsoft Internet Explorer 5.5 or later. 

• A Win32 development tool to develop your application, such as Microsoft Visual 
C++, Microsoft Visual Studio .NET 2005 or Microsoft Visual Basic.  
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Unpacking and connecting up 
Eurotech Ltd’s Windows XP Embedded Development Kits are shipped ‘ready to run’. 
You simply remove the various items from their packaging and connect them up. 

 
Remember that a number of these items are static-sensitive, so you must take 
standard anti-static precautions while unpacking. See Anti-static handling, 
page 7. 

Using a VGA monitor 
If you are using a VGA monitor, you can get started quickly and ensure everything is 
connected properly by referring to the diagram and procedure below.  

 

VFRNT

USB 5&6

USB 3&4

ATX

PIN 1
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To unpack and connect up the GEMINI, follow these steps: 

1 Remove the GEMINI CPU board from its packaging and place it on a static-free 
work surface. 

2 Connect up the breakout board, as shown in the diagram on the preceding page. 

3 Do one of the following: 

• Plug the dual PS2 breakout cable into connector CN_PS2. Plug a keyboard into 
the socket with a purple marking, and a PS2 mouse the socket with a green 
marking. 

-or- 

• Plug a USB keyboard and mouse into any of the USB sockets. 

4 Plug a VGA monitor into the rear socket, as shown in the diagram on the preceding 
page.  

5 Using the supplied cable, connect the USB-VSSD-CARRIER board to USB 
connector CN_USB2. Make sure that the cable is round the correct way - so the 
red stripe is connected to pin 1 on the USB-VSSD-CARRIER board. 

6 Plug the ATX Power Supply Unit (PSU) cable into the socket, as shown in the 
diagram on the preceding page.  

7 Fit the appropriate power lead to the PSU.  

 
The power switch is located on the GEMINI breakout board.  
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Using a flat panel monitor 
If you are using a flat panel monitor, you can get started quickly by referring to the 
following diagram and procedure. For details of connections for the mouse, keyboard, 
flash disk and breakout board, see the diagram on page 11.  

 

 ATX CONN PIN 1 Power supply

Backlight 
inverter

Backlight 
inverter 

cable

LVSD cable

TSC1 (PL3 & 5) 

COMMS cable 

TSC1 power 
cable (+5V DC) 
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To unpack and connect up the flat panel monitor, follow these steps: 

1 Plug one end of the flat panel interface cable into the GEMINI flat panel connector 
CN_LVDS, and the other end into the flat panel. 

2 Plug one end of the flat panel backlight cable into the GEMINI backlight connector 
CN_INV, and plug the other end into the backlight inverter. 

 

Make sure the power is off while connecting the LCD, as the backlight 
inverter generates high voltages. 

3 If the touchscreen is to be used:  

• Use the serial adapter cables provided to connect the 9-way D-type on the 
TSC1 to CN_COM3 on the GEMINI.  

• Connect the touchscreen to the TSC1 using the 8-way ribbon cable.  

 
Pin 1 is marked on the touchscreen and the cable, but it can be 
difficult to see.  

• Connect the TSC1 to the power supply. 
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BIOS settings 
The BIOS on the GEMINI is from Phoenix - AWARD. Should you need to reset the 
BIOS, follow these steps:  

1 Reset the board, wait for the system speaker to ‘beep’ and then press DEL. The 
BIOS set up screen is displayed. 

2 Use the arrow keys on your keyboard to select Load Optimised Defaults. Press 
ENTER and then select [Y]es and press ENTER. 

3 Use the arrow keys on your keyboard to select Standard CMOS Features and 
press Enter.  

4 Navigate down to Drive A and using the Page Up and Page Down keys, set it to 
None. 

5 Press Escape to return to the main menu. Use the arrow keys on your keyboard to 
select Advanced Chipset Features and press Enter.  

6 Navigate down to LCD Type and using the Page Up and Page Down keys, set it to 3. 

7 Press Escape to return to the main menu. Use the arrow keys on your keyboard to 
select Save & Exit Setup and press Enter. Press Enter again to confirm. 

8 Press Enter. The GEMINI reboots with the correct BIOS settings. 

 

We use these settings when assembling the GEMINI and recommend that you 
use them if you need to reset the BIOS. 
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Flat panels 
The default BIOS, when configured as shown on the previous page, can be used to 
drive a 15" AUO TFT flat panel (part number G150XG01), as supplied in the flat panel 
variant of the Development Kit. 

For information about other flat panels supported by the GEMINI, contact technical 
support. See Appendix A – Contacting Eurotech Ltd, page 46. 
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Touchscreen 
The flat panel version of the Development Kit is supplied with a touchscreen. A driver 
for the touchscreen is included, but is not enabled by default as it utilises a COM port. 
A shortcut is provided on the desktop to make it straightforward to start the 
touchscreen driver. 

To use the touchscreen on your flat panel, follow these steps:  

1 Ensure the GEMINI is powered off and the touchscreen is fixed securely to the flat 
panel. 

2 Ensure that all electrical connections for the touchscreen and touchscreen 
controller are made. 

 

Make sure that the touchscreen data wires are kept away from the power 
wires for the LCD backlight and inverter, as this can cause interference 
and erratic behaviour from the touchscreen.  

3 Connect a +5V supply to the touchscreen controller, using the supplied cable. 

4 Connect the touchscreen to the TSC1, using the 8-wire connector. 

 
Pin 1 is marked on the touchscreen with an arrow. The 8-wire ribbon 
cable must be attached so the red wire is connected to pin 1. 

5 Connect the output of the TSC1 to serial port COM3 (CN_COM3) on the GEMINI 
board. 

6 Make sure that jumpers LK2, LK3, LK4 and LK6 are fitted on the TSC1, so that it 
is operating in 10-bit mode. 

7 Switch the GEMINI on and allow it to boot into Windows XP. 

8 Using a mouse, double-click the Touchscreen Driver icon on the desktop. 

The touchscreen and TSC1 are configured and calibrated as part of the production 
process, so are ready to use. If the touchscreen needs to be recalibrated, launch the 
calibration process by selecting Run from the Start menu and entering "arctouch –c". 

If you download a new XP image to the GEMINI, the calibration routine is carried out 
the first time the touchscreen driver is run. 

To make the touchscreen driver start automatically every time Windows XP Embedded 
starts, copy the shortcut on the desktop to the Startup folder on the Start menu. 

For more details, refer to the document Touchscreen.html. This is on the DVD that 
accompanies this Development Kit, in the folder Documentation\Datasheets\TSC1. 
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Using the supplied Windows XP Embedded image 
When switched on, the GEMINI loads the installed copy of Windows XP Embedded. 
This may take up to two minutes. When loading is complete, the Windows XP 
Embedded desktop appears. You do not need to enter a user name and password, 
because Windows XP Embedded is set up to login automatically.  

 
The default username and password used in the automatic login are as 
follows: 
Username: Administrator 
Password: Administrator 

At this point the GEMINI behaves in much the same way as the normal desktop 
versions of Windows XP (Home and Professional), but with fewer applications 
available. Commands and utilities can be run from the Start menu in the normal way. 

Networking 
The version of Windows XP Embedded installed on the flash disk contains a driver for 
the on-board Ethernet controller and Microsoft TCP/IP networking. It also contains a 
DHCP client that automatically configures TCP/IP to run on your network. If you don’t 
use a DHCP server for network configuration you must configure TCP/IP manually 
from the control panel.  

If the GEMINI is connected to a workgroup-based network it appears in the network 
neighbourhood under the name ‘WORKGROUP’. The name assigned to the machine 
begins with GEMINI followed by a random series of characters unique to your system 
(generated by Windows XP Embedded). This means the name format is GEMINI-
xxxxxxxx, where xxxxxxx is the random part of the name, for example GEMINI-
VCVJAB1P.  

To find out the name assigned to your GEMINI, follow these steps: 

1 Open a Command Prompt on Windows XP Embedded by selecting Start → All 
Programs → Accessories → Command Prompt. 

2 Type ipconfig /all at the Command Prompt. 

The Host Name assigned to your GEMINI is the first item reported. This is your 
machine name. 

 
Other useful information is also displayed in the output of the ipconfig /all 
command, such as the IP address assigned to the Ethernet adapters. 
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Files and folders on the GEMINI can be shared, allowing easy access from another 
system. To share a folder on the GEMINI: 

1 Right-click on the folder. 

2 Select Sharing and Security. 

3 Assign a name to the share. 

If you want to join the GEMINI to a windows XP domain-based network, you must 
change from a workgroup to a domain-based network and enter the name of the 
domain you wish to join. To do this, follow these steps:  

1 Select Start → Control Panel → System → Computer Name → Change → 
Domain. 

2 Enter the name of the domain you want to join and click on OK. 

You are asked for the user name and password of an account with permission to 
join the domain. You need to obtain this information from your network 
administrator. 

3 Enter the user name and password, and click on OK. Once the GEMINI appears in 
your network neighbourhood, files can be copied to and from the board in the same 
way as with any other desktop system on the network. 

Enhanced Write Filter 
RAM Enhanced Write Filter (EWF) allows you to protect the operating system so that 
any writes to the flash memory are not permanent. Instead, they are redirected to an 
overlay in RAM memory so that whilst the operating system is running they appear 
permanent, but when it is shutdown or rebooted the RAM overlay writes are discarded 
and the operating system reverts to the same state it was in at the previous boot.  

The Standard XPe image is supplied with RAM EWF functionality included but 
disabled. A utility called EWF Manager is located on the desktop and in the Start 
menu. This utility can be used to enable and control the status of EWF.  

When the status of the EWF is changed, the update will not happen immediately. The 
change only takes effect as the operating system is shut down. When you exit EWF 
Manager, you may be prompted to restart the machine to apply any changes.  

An API is included that allows the user to query and control the status of EWF from 
within their application. Full details of the functions and structures, along with some 
sample code, can be found at www.msdn.microsoft.com.  

http://www.msdn.microsoft.com/
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File Based Write Filter 
File Based Write Filter (FBWF) is very similar to Enhanced Write Filter. The main 
difference is that instead of protecting the entire flash disk, it allows you to be selective 
about which folders and files are protected, and thereby ‘poke holes’ in the protection 
for certain folders which might require write access e.g. log files. 

A command-line application called FBWFMGR is included to allow you to manage 
which folders and files are excluded from the write protection offered by FBWF. 

• To enable FBWF, open a Command Prompt on Windows XP Embedded by 
selecting Start → All Programs → Accessories → Command Prompt. 

Then type the following: 
fbwfmgr /enable 

• Just enabling FBWF is not enough to protect the flash disk. You must tell FBWF 
which volume it should be enabled for. To do this, type: 
fbwfmgr /addvolume c: 

• If you wanted to exclude a folder called C:\logfiles, from the FBWF protection, 
type: 
fbwfmgr /addexclusion c: \logfiles 

• To remove the exclusion, type: 
fbwfmgr /removeexclusion c: \logfiles 

• To disable FBWF, type: 
fbwfmgr /disable 

 

File Based Write Filter cannot be used at the same time as Enhanced Write 
Filter. If both are enabled simultaneously, EWF will take priority and protect the 
entire flash disk.  

Application development 
From an application development viewpoint, Windows XP Embedded behaves in the 
same way as desktop Windows XP. This means you can use the full range of Microsoft 
development tools including, for example, Visual Basic, Visual C++, and so on. The 
Windows XP Professional versions of the software development and driver 
Development Kits can also be used with Windows XP Embedded. 
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Remote debugging for Microsoft Visual Studio 6 
A copy of MSVCMON.EXE, Microsoft’s remote debugging tool for Visual Studio 6, is 
included on the GEMINI, in the folder C:\Windows\System32. A shortcut to 
MSVCMON.EXE is available on the desktop, called VS6 Remote Debugging. To 
debug applications on the GEMINI, follow these steps:  

1 Launch MSVCMON.EXE by double-clicking on the VS6 Remote Debugging 
shortcut on the desktop and then clicking on Connect. 

2 Build your application on your host system in the normal way, using tools such as 
Visual C++. 

3 Select Debug Remote Connection from the Build menu within Visual C++ on 
your development machine, and then select Network (TCP/IP). 

4 Click on Settings and enter the name or IP address of your GEMINI system. 

When the debug session is started from Visual C++, the code actually runs on the 
GEMINI. For further details visit Microsoft’s developer network site at 
www.msdn.microsoft.com and search for ‘debugging remote applications’. 

Remote debugging for Microsoft Visual Studio .NET 2005 
You can debug applications developed in Microsoft Visual Studio .NET 2005, by 
running the Remote Components Setup from your Visual Studio .NET 2005 
installation media. 

To install full remote debugging support from your Visual Studio .NET CD/DVD follow 
these instructions:  

1 Insert the Visual Studio CD/DVD into a CD/DVD drive connected to the GEMINI. 

2 On the Start menu, choose Run. 

3 Type the following (assuming your CD/DVD drive is D:): 

D:\vs\Remote Debugger\x86\rdbgsetup.exe 

The installer will run through the installation procedure. When prompted, do not install 
remote debugging as a service. 

Visual Studio .NET 2005 remote debugging support is installed onto the GEMINI.  

 
For more information and an example of how to use remote debugging, 
please refer to the GEMINI XP Embedded Development Kit DVD. 

 

http://www.msdn.microsoft.com/
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Device drivers 
As a general rule, it should be possible to install any device driver in Windows XP 
Embedded that is available for Windows XP Professional. The same technique for 
installing the driver in Windows XP Professional will also usually work under Windows 
XP Embedded. 

To install the device driver, follow the device manufacturer’s instructions for installing 
the device under Windows XP Professional. 

 

Many of the base system drivers are not included in the Standard XPe image, 
to preserve disk space. If you try to install a device, which the manufacturer 
states is natively supported by Windows XP, or relies on a base Windows XP 
component, Windows XP Embedded may not recognise it. The missing driver 
files can often be copied from a standard Windows XP Professional SP2 
installation on another computer.  

.NET framework 
Microsoft’s .NET Framework v3.0 is included in the StandardXPe image. To develop 
.NET applications that run on this image, use Microsoft Visual Studio .NET 2005, which 
supports application development for .NET Framework v3.0.  

To perform remote debugging with applications that require the .NET Framework, 
additional remote debugging tools must be installed on the GEMINI. These tools 
require approximately 50MB of disk space, so are not installed by default. For an 
explanation of the installation procedure, see Remote debugging for Microsoft Visual 
Studio .NET 2005, page 21. 

Changing the startup logo 
The Windows XP Embedded image supplied with this Development Kit includes a 
custom startup logo, which appears between the BIOS screen and the Microsoft 
Windows XP splash screen on startup. This logo can be changed to a custom image of 
your own, and can also be set to replace the Microsoft Windows splash screen if you 
want it to stay on the screen for longer. 

To change the logo, you must replace the file called boot.bmp in the C:\Windows 
folder of the flash disk. Your new logo must comply with the following rules: 

• The image size must be exactly 640 x 480. 

• The colour depth must be 4-bit (16 colours). 

• The file must be in the Windows Bitmap (BMP) format. If you wish to save disk 
space, an RLE encoded BMP is recommended. 
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By default, the logo is configured as a quick boot logo, which appears for a few 
seconds as the GEMINI begins to boot. You can change the length of time for which 
the logo appears on the screen by following these instructions: 

1 Select Start → Control Panel → System → Advanced → Startup and Recovery 
→ Settings → Edit. 

 The hidden system file boot.ini is displayed in Notepad for you to edit. 

 

Editing the boot.ini file incorrectly can cause serious problems for your 
computer. Please use extreme caution. 

2 Change the last line to select the duration you want the boot logo to be displayed 
on the screen, as follows:  

• No boot logo. Windows XP Embedded boots without displaying a custom logo. 
The BIOS screen is displayed then replaced by a quick progress bar across the 
bottom of the screen, followed by the Starting Microsoft Windows screen. To 
achieve this, type: 

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP 
Embedded" /fastdetect 

• Quick boot logo. The custom logo is displayed briefly (for approximately 3 
seconds) during start up, replacing the progress bar that appears between the 
BIOS screen and the Microsoft Windows XP splash screen. To achieve this, 
type: 

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP 
Embedded" /fastdetect /bootlogo:boot.bmp 

• Extended boot logo. The custom logo replaces the progress bar and the 
Windows XP splash screen. It appears after the BIOS screen and stays until 
the desktop and mouse cursor appear (approximately 30 seconds). If you 
choose this logo, the image is static and there is no progress bar to indicate 
that Windows is loading. We therefore recommend that you include some text 
at the bottom of the image saying, for example, ‘Please wait…’. To achieve this, 
type: 

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP 
Embedded" /fastdetect /bootlogo:boot.bmp /noguiboot 
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3 When you have made your changes, click on File → Save. 

Next time the GEMINI is booted, the new boot logo settings will be used.  

 

If you are using the Extended boot logo you may want your logo still to be 
displayed once Windows has booted past the startup splash screen, and the 
mouse cursor has appeared. Setting the following registry keys will keep it 
on the screen for longer and set it as the default wallpaper: 
[HKEY_CURRENT_USER\Control Panel\Desktop] 
"Wallpaper"="C:\Windows\boot.bmp" 

[HKEY_USERS\.DEFAULT\Control Panel\Desktop] 
"Wallpaper"="C:\Windows\boot.bmp" 

 If you want to change the blue background (which is shown briefly as the 
mouse appears during the boot process) to black, you can do so with the 
following registry setting: 
[HKEY_USERS\.DEFAULT\Control Panel\Colours] 
"Background"="0 0 0" 

 

 

Editing the registry incorrectly can cause serious problems that may require 
reinstalling Windows XP Embedded on your GEMINI. We cannot guarantee 
that problems resulting from the incorrect editing of the registry can be 
solved. 
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Remote desktop connection 
During the development of applications that are to run on a system without a display 
(headless systems), Microsoft Remote Desktop Connection can be used to 
communicate with the GEMINI. Remote Desktop Connection enables the desktop of 
the headless system to be displayed in a window on the development system. The 
Remote Desktop tools are provided as standard with Windows XP Professional. Users 
of other Windows versions can download them from www.microsoft.com.  

To view the desktop of the GEMINI, you must initiate the connection as follows:  

1 Select Start → All Programs → Accessories → Remote Desktop Connection. 
The Remote Desktop Connection window is displayed: 

 

 You can modify the Options if required, before connecting through Remote 
Desktop. 

2 Type in the remote computer name and click on Connect. Remote Desktop 
initiates communication to the GEMINI and displays a log on box. This can take up 
to 30 seconds. 

3 Enter the user name Administrator and password Administrator. These are case 
sensitive:  

 

http://www.microsoft.com/
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 The GEMINI’s desktop is displayed in a window on the host development system. 
You can use this window as if your keyboard and mouse were plugged directly into 
the GEMINI: 

 

To shutdown the remote system, at the command prompt on Remote Desktop run 
shutdown -s.  

To restart the remote system, run shutdown -r at the command prompt.  
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Support software on the Development Kit DVD 
The Development Kit is supplied with a DVD, which contains a number of support 
programs and an example image. This software is designed to help you develop your 
application and to create a version of Windows XP Embedded that best suits your 
project requirements.  

The Development Kit DVD is divided into five main areas: 

• Sample Images: A pre-built Windows XP Embedded image. 

• Documentation: This Quickstart manual, the GEMINI processor 
manual, and datasheets. 

• Target designer extensions: Components and configurations for Microsoft Target 
Designer to allow you to rebuild the same image, 
customise, or create your own image.  

• Development Tools: Tools to help create and build new images.  

• GEMINI Tools: Additional tools for the GEMINI board. 

When you insert the DVD in your development system it autoruns. A HTML page is 
displayed describing various parts of the DVD. 

If this page does not appear, use Windows Explorer to select the DVD and then 
double-click on the file readme.htm. 
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Sample image 
The GEMINI Windows XP Embedded Development Kit includes a sample Windows XP 
Embedded image called Standard XPe. The Standard XPe image is the same as the 
image installed on the flash disk for the GEMINI board in the Development Kit. 

Further details about the image are provided below: 

Summary: Includes a broad array of components to support a wide base 
of applications/uses. 

Approximate image size: 1GB (900MB remaining) 

Contains: • Standard Windows XP kernel (Service Pack 2). 

• .NET framework v3.0. 

• EWF (Enhanced Write Filter). 

• FBWF (File Based Write Filter). 

• Intel Graphics driver. 

• Intel Network drivers. 

• Windows Media Player 11. 

• Internet Explorer 7. 

• Full system administration. 

• TCP/IP v4 and v6, including Winsock & command line 
utilities. 

• Native code remote debugging for Microsoft Visual Studio 
6. 

• RAS with support for dial in, dial out and VPN. 

• Simple Network Management Protocol (SNMP). 

• Full domain and workgroup participation with file and print 
sharing. 

• Internet Information Services (IIS) including support for ASP 
and ASP.NET. 

• Touchscreen. 

• Bluetooth device support. 

• CD writing support. 

• DirectX 9.0c. 

• Remote administration. 

• USB storage and input device support. 

• Message Queuing (MSMQ). 

• Windows Management Instrumentation (WMI). 
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The Standard XPe image is supplied on the DVD in two different formats.  

• The Binary folder contains a single file, which is a binary image for use with the 
Intel USB flash disk supplied with the Development Kit. This image will not work 
with any flash disks from other manufacturers. 

• The Source folder contains the same files, which are in the binary image, but can 
be used with another manufacturer’s flash disk (of the same size) if you wish. 

In addition to the two file formats, there are two different versions of the binary image, 
created at different points during the creation of the image: 

• The sealed version of the image is intended for general use. The very first time a 
sealed image is booted up, it always generates a new Security ID (SID) and a new 
network name for the system. This ensures that when more than one GEMINI is 
connected to the same network, each one is unique. 

• The prefba version of the image has not run through the ‘first boot agent’ or been 
sealed. This only needs to be used if you wish to create a master image, for 
example a custom image where you have installed your own application. Once you 
are happy with the image you can seal it and clone it. Any clones will then generate 
a new Security ID (SID) and a new network name when they are first booted up. 

For instructions on how to install a Binary image see Reinstalling the supplied 
Windows XP Embedded image, page 30. 

For instructions on how to install a Source image see Transferring a newly created 
image to the GEMINI, page 38. 

 

We recommend you do not use the prefba image for anything other than 
creating a master image, as it takes much longer to complete its first boot. 

For general use, always use the sealed version of the image. 
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Reinstalling the supplied Windows XP Embedded image 
If you wish to reinstall Windows XP Embedded for the GEMINI board as it was 
supplied with this Development Kit, you can do so using the Development Kit DVD 
provided.  

 

You must install the Development Workstation Tools and Sample Images 
from the Development Kit DVD on your development computer before 
continuing. The instructions below assume you have chosen the default 
installation directories. 

 

 

Incorrect use of the CFCLONE tool could result in you overwriting your hard 
disk. Make sure that you follow the instructions carefully, and are specifying the 
correct drive for the Intel USB flash disk. 

To reinstall Windows XP Embedded for the GEMINI board as it was supplied, follow 
these steps: 

1 Power off the GEMINI and remove the Intel flash disk module. 

2 Using the supplied cable, plug the Intel flash disk into a spare USB slot on your 
development computer. 

 

The Intel flash disk is capable of operating under both USB and USB2 
modes. If your computer has a USB2 slot, it will greatly reduce the time 
required to program the flash disk. 

3 Using Windows Explorer, determine the drive letter assigned for the Intel flash disk. 
For the rest of these instructions, we assume that the Intel flash disk is E:. 

4 Open the Command Prompt from the Start menu. 

5 Change to the relevant directory by typing the following: 
CD\GEMINI\IMAGES\StandardXPe\BINARY\SEALED. 

6 Run the CFCLONE utility to reprogram the flash disk by typing the following 
command: 
CFCLONE StandardXPe.bin E: 

 

If any applications tried to autorun when you plugged in the Intel USB 
flash disk, you must close these down before the CFCLONE utility will 
run, as it must have exclusive access to the flash disk. 

7 Click on the icon in the system tray near the clock to Safely Remove Hardware, 
once the CFCLONE utility has completed.  
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8 Once Windows has displayed the message saying that it is now safe to remove the 
hardware, unplug the Intel USB flash disk.  

9 Plug the flash disk module in the GEMINI and switch the power on. 

Windows runs through the final part of its ‘First Boot’. It takes approximately 5 
minutes for the desktop to appear. Once this is complete, the GEMINI is back to its 
original factory settings. 
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Setting up Windows Embedded Studio 
The GEMINI Windows XP Embedded Development Kit is supplied with a pre-built 
image of the Windows XP Embedded operating system. In cases where the pre-built 
image doesn’t offer suitable functionality, Microsoft Windows XP Embedded Studio can 
be used to customise the existing image or to create a completely new one.  

The Target Designer extensions supplied on the Development Kit DVD support 
Windows XP Embedded SP2 Feature Pack 2007.  

Target Designer extensions for the following devices and utilities are supplied on the 
support DVD: 

• Intel network controller drivers. 

• Intel graphics driver. 

• Intel SMBUS driver. 

• Realtek AC97 codec for sound support. 

• ArcTouch touchscreen application. 

• Enhanced Write Filter Manager application. 

• Startup logo. 

• Microsoft Foundation Class Library for Visual Studio 2003. 

• Microsoft Visual C++ Native Remote Debugging Tools. 

• Microsoft TweakUI application. 

The DVD also contains configuration information for Microsoft Windows XP Embedded 
Studio that enables the pre-built image to be reproduced or used as the basis for a 
custom configuration.  

 

A copy of Microsoft Windows XP Embedded Studio which consists of Target 
Designer and Component Designer is included as part of the Development 
Kit. These tools let you create time-limited (120 days) evaluation versions of 
the Windows XP Embedded operating system. 

A full copy of Microsoft Windows XP Embedded Studios, must be obtained 
from a Microsoft distributor. 

Installation 
Install Microsoft Windows XP Embedded Studio SP2 Feature Pack 2007 on the 
development PC and then install the GEMINI Target Designer Extensions package 
from the GEMINI Windows XP Embedded Development Kit DVD.  
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Target Designer extensions 
To import Target Designer extensions, follow these steps:  

1 Make sure you have write access to the Repositories folder (which is in the 
Windows Embedded Data folder). If you don’t, create a share with your user name, 
in the standard way by right-clicking on the Repositories folder and then selecting 
Properties → Sharing.  

2 Start Target Designer and select Component Database Manager from the Tools 
menu. The Component Database Manager window is displayed:  

 

 
Target Designer extensions are stored in files with an .SLD extension.  

3 Click on Import. The Import SLD dialog box is displayed. 

4 Select the file GEMINI.sld from the following folder: 

C:\GEMINI\TDExtensions\Components\GEMINI 
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5 Click on Import. Target Designer imports all files required for the GEMINI and adds 
them to its internal database: 

  

6 Click on Close. 

7 Repeat steps 3 through 6 to for the Common Components.sld file in the following 
folder: 

 C:\GEMINI\TDExtensions\Components\Common 

8 The GEMINI.sld file contains a design template for the GEMINI board. The design 
template has all the components for all the devices on the GEMINI board. If you 
want to create a new configuration, you can add this component to your 
configuration. This design template appears as GEMINI under Design Templates 
in the list of components. 

 

The Standard XPe image is based on the Update ROLLUP 1.0 for 
Windows XP Embedded and includes the QFE update KB929403 for File 
Based Write Filter. You will need to download this update from Microsoft’s 
website before you can rebuild the Standard XPe image. 
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Configuration information 
Once all the components have been imported to the component database, you can 
open the configuration in Target Designer. The Standard XPe image is installed as part 
of the installation package included on the Development Kit DVD. By default, it is 
installed to the following folder: 

C:\GEMINI\TDExtensions\Configuration 

 

To make it simple to save the configuration file once you’ve edited it, we 
recommend that you copy the configuration file to your local hard disk and 
open it from there, instead of from the DVD. 

To view target device settings, follow these steps:  

1 Open Target Designer. 

2 Click on Settings, under StandardXPe.slx in Target Designer. 

3 Click on Show, under Target Device Settings. 

The target device settings shown suggest that images created using these settings 
must be run from drive C:, with a boot partition size of 2048MB. These are the 
settings used to create the image shipped with this GEMINI Windows XP 
Embedded Development Kit. 

If you want to use a storage device with a boot partition size other than 2048MB, 
change the Boot Partition Size settings under Target Device Settings. 

If you want to use a boot drive other than the C: drive, you must change the target 
device settings as appropriate. The settings you need to change may include the boot 
drive, Windows folder, program files folder, documents and settings folder and the boot 
ARC path. 

 
To view information about any of these settings, click on (more info) next to 
the name of the setting. 

To create a new XP Embedded image with these target device settings, copy the new 
image to the drive (as explained in Transferring a newly created image to the GEMINI, 
page 38) and then boot the system. 
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Viewing components 
The following image shows what you see when viewing components: 

 

 
To view all the components, set the visibility to 100. 

To set the visibility, open Target Designer and select Tools → Options → Advanced 
→ Minimum visibility.  

If you just want to view components supplied by us for the GEMINI, you can create a 
filter by following these steps:  

1 Open Target Designer and select Tools → Filter Manager → New. 

2 Enter the name GEMINI to represent this new filter. 

3 Double-click on Component belongs to the following package under Filter 
Rules. 

4 Double-click on Component belongs to the following package (which now 
appears in the Filter Description window with the heading Filter Rule and Edit 
box), and choose the following package: 

 GEMINI 

5 Click on OK to return to the Filter Editor window. 

6 Change the Combine using selector to OR. 

7 Double-click on Component belongs to the following package under Filter 
Rules. 
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8 Double-click on Component belongs to the following package (which now 
appears in the Filter Description window with the heading Filter Rule and Edit 
box), and choose the following package: 

 Common Components 

9 Click on OK to return to the Filter Editor window. 

10 Click on OK in the Filter Editor window. 

11 Click on Apply Filter. This displays all the components supplied by us for the 
Windows XP Embedded GEMINI Development Kit: 

 

If you want to view all the components in the Target Designer, select All Components 
from the Filter drop-down list in the left-hand pane of the main Target Designer 
window. 
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Transferring a newly created image to the GEMINI 
The flash disk module supplied with the Development Kit is installed with a copy of the 
Standard XPe image. This contains many of the features available in Windows XP 
Embedded and is well suited to a development environment. Customers who wish to 
use an image created by Target Designer must generate the image on a host 
development system before transferring it to the flash disk on the GEMINI. 

 

All the images for the GEMINI Windows XP Embedded Development Kit are 
designed for 2GB Intel USB Flash disks only. If you want to use a storage 
media size other than 2GB, you must use Windows XP Embedded Studio to 
modify the boot partition size from the corresponding configuration, and 
rebuild the image.  

In addition the Intel USB Flash Disk has to be seen as drive C: on the 
APOLLO board for the images shipped with this Development Kit to work. For 
details, see Configuration information, page 35. 

There is a CFLCONE image file included on the development kit DVD of a read 
partitioned and formatted 2GB Intel flash disk. You can use the Intel flash disk module 
supplied with your development kit instead of partitioning and formatting using a new 
Intel flash disk.  

Partitioning a new Intel USB Flash Disk module 
Intel USB Flash Disk modules are supplied completely blank, without any partitions 
defined. To ensure that they will work correctly with XP Embedded, they must be 
partitioned and formatted before they can be used. 

 
The following procedure erases everything from the USB Flash Disk module, so 
make sure there is no useful data on the module before you begin. 

To partition the new Intel USB Flash Disk module, follow these steps: 

1 Power on the GEMINI and allow it to boot into Windows XP Embedded. 

2 Plug your new USB flash disk module into an available USB port on the GEMINI 
using the cable supplied with the Development Kit. Windows should recognise the 
new hardware. 

 

If a window appears with the message “This disk or device contains more 
than one type of content. What do you want Windows to do?” click the 
Cancel button. 
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3 Select Start → Restart. Allow Windows to restart. 

 

This step is vital. Windows must be allowed to restart at this point with the 
USB flash disk connected, otherwise it will not be made to boot correctly 
later on. 

4 Open the Command Prompt from the Start menu. The command prompt window 
is displayed. 

5 Please refer to the screenshot below. Type the commands shown in red to remove 
the existing partition, create a new one, and assign it a drive letter.  

 
In the following example, the new Intel Flash disk has the drive letter D: 
assigned to it, and is highlighted in blue. 
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Once the USB Flash disk module has been partitioned, it must be formatted. See 
Formatting a USB Flash Disk module below for an explanation of this procedure. 

 

Incorrect use of the CFCLONE tool could result in you overwriting any other 
disks connected to your GEMINI. Make sure that you follow the instructions 
carefully, and specify the correct drive for the Intel USB Flash Disk. 

 

Formatting a USB Flash Disk module 
To transfer a complete Windows XP Embedded image, the USB Flash Disk module 
must be formatted to use NTFS.  

 

The following procedure erases everything from the USB Flash Disk module, so 
make sure there is no useful data on the module before you begin. 

To erase the flash disk module, follow these steps: 

1 Boot your GEMINI into Windows XP Embedded, as described in steps 1 to 3 at the 
beginning of the Partitioning a new Intel USB Flash Disk module section, page 738. 

2 Open the Command Prompt from the Start menu. 

3 Once at the Command Prompt, type FORMAT D: /FS:NTFS and press Enter. 

4 When asked if you wish to proceed with the format answer [Y]es and press Enter. 

5 Once the format has completed, you can supply a name for the flash disk, or simply 
press Enter. 

Once the USB Flash Disk module has been formatted, you will need to transfer your 
image onto it. See Transferring an image below, for an explanation of this procedure. 

Transferring an image 
Before transferring an image to the GEMINI, the Intel USB Flash Disk must be 
partitioned and formatted. This can be done by formatting it as described in Preparing 
a new Intel USB Flash Disk module, page 38, and Formatting a USB Flash Disk 
module, page 40. 

Once the device has been prepared, to transfer the image onto the GEMINI, plug the 
Intel flash disk module into your development computer, and simply copy the files using 
Windows Explorer. All the files and folders should be copied to the root folder. For 
example, if your USB flash disk module appears as drive D, copy all the folders and 
files in the StandardXPe folder to the D: drive. 
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When copying is complete, the folder structure for drive D: should look something like 
this: 

 
Click on the Safely Remove Hardware icon on the taskbar near the clock, and then 
click on Safely remove USB Mass Storage Device – Drive(D:). Once the 
confirmation message has appeared, you can unplug the Intel flash disk module, and 
plug it back into your GEMINI. 

When you turn the GEMINI on, Windows runs through the First Boot Agent (FBA). 
Depending on the size and complexity of your XP Embedded image, this can take a 
while to complete. 
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Security and image duplication 
Windows XP Embedded images can be duplicated using one of two possible methods: 
standalone and cloning. The standalone method is not recommended for production, 
but is useful during development, whereas the cloning method may be used during 
production.  

Whichever method is used, it is essential that each duplicate module is allocated a 
unique computer Security ID (SID). You must also ensure that you have the 
appropriate Windows XP Embedded licenses for each computer. 

Start from the new image prepared using Microsoft Windows XP Embedded Studio. 

Flash Disk requirements 
If you want to run the supplied sample image using any other flash disk or 
CompactFlash, the boot partition size must be 2048MB. If you wish to use a different 
size flash disk, you must prepare the Windows XP Embedded image accordingly using 
Windows XP Embedded Studio, as explained in Configuration information, page 35. 

 

All the Windows XP Embedded images shipped with this Development Kit are 
configured for a boot partition size of 2048MB. 

The boot drive must be the C: drive, as these images are configured to run 
from this drive. 

Duplication of Windows XP Embedded images 
Proper duplication can be achieved using either the standalone or the cloning method. 
These are described below: 

Standalone method 
This method simply involves preparing the flash disk, copying the required folders and 
files to your flash disk module, and rebooting the system. Follow these steps:  

1 Copy all the folders and files for the required image to a properly partitioned and 
formatted flash disk. For more information about flash disk preparation, formatting 
and image copying, see Transferring a newly created image to the GEMINI, page 
38. 

2 Boot the individual system. 

The sample image supplied with this Development Kit will only work with 2048MB 
flash disk devices. The complete boot process takes approximately 20 minutes for 
each system. When complete, the Windows XP Embedded desktop is displayed. 

Repeat this procedure for each individual flash disk to get duplicate OS images, each 
with its own unique SID. 
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Cloning method  
You can use the cloning method described in Microsoft Windows XP Embedded 
Studio. This is a two-stage process. The first stage involves creating a master copy, 
which is duplicated in the second stage to create clones.  

To use the cloning method, the System Cloning Tool component must be included in 
the image. The sample image supplied with this Development Kit already includes this 
component. You will also require a hard disk with enough free space to copy the entire 
flash disk device, or a suitable network connection to transfer the file to/from a remote 
computer.  

Creating the master copy (resealing the image) 
Creating the master copy is identical to creating a standalone system. Follow the 
instructions described in the Standalone method on page 42, making sure that the 
System Cloning Tool component has been included.  

Once the Windows desktop has been displayed, you can make any changes to the 
image, that you want to be reproduced once it has been cloned. 

When satisfied that you have an image you want to use as your master, follow the 
instructions below: 

1 Boot the GEMINI so that you are presented with the Windows Desktop. 

2 Open a Command Prompt from the Start menu and type the following command: 

fbreseal 

After a few seconds, the following message is displayed: 
 Machine resealed! Click to shutdown or reboot. 

3 Click on Shutdown and wait for Windows to shutdown. This flash disk is now the 
master copy. 

 
Make sure this master copy is not used to boot the system again, before 
you clone it. A Windows XP Embedded image can only be resealed once. 

4 Plug the Intel flash disk into a spare USB slot on your development computer, using 
the supplied cable. 

 

The Intel flash disk is capable of operating under both USB and USB2 
modes. If your computer has a USB2 slot, it will greatly reduce the time 
required to program the flash disk. 
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5 Determine the drive letter assigned for the Intel flash disk, using Windows Explorer. 
For the rest of these instructions, we assume that the Intel flash disk is E:. 

6 Open the Command Prompt from the Start menu. 

7 Run the CFCLONE utility to take an image of the flash disk by typing the following 
command: 
CFCLONE E: C:\MyImage.bin 

 

If any applications try to autorun when you plugged in the flash disk, you 
must close these down before the CFCLONE utility will run, as it must 
have exclusive access to the flash disk. 

8 Type a description for the image when prompted. 

9 Once the CFCLONE utility has completed, click on the icon in the system tray to 
Safely Remove Hardware. Once Windows has displayed the message saying that 
it is safe to remove the hardware, unplug the flash disk. 

The file that was created by the CFCLONE tool is your master image. This file must be 
kept safe so that it can be used to create clones of your image. 

Creating the clone Flash Disk from the master  
To copy the master image onto another flash disk (the clone), follow these steps:  

1 Using the supplied cable, plug the blank Intel flash disk into a spare USB slot on 
your development computer. 

 

If no drive letter is allocated to your new flash disk, go to Administrative 
Tools in Control Panel, load the Computer Manager application and click 
on the Disk Manager section. This will initialise the new disk and allow 
you to allocate it a drive letter. 

2 Run the CFCLONE utility to program the flash disk by typing the following 
command: 

CFCLONE C:\MyImage.bin E: 

3 When the CFCLONE utility has completed, click on the icon in the system tray to 
Safely Remove Hardware. 

4 Once Windows has displayed the message saying that it is safe to remove the 
hardware, unplug the flash disk. Insert the newly programmed flash disk module in 
the GEMINI and switch the power on. 

When Windows starts it will run through the final part of its ‘First Boot’. 
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Each clone created this way has a unique SID and network name when it completes 
the boot process, and shows the Windows XP Embedded desktop. 

 

Do not duplicate the image from a cloned flash disk after it has completed the 
entire boot process. This would result in duplication of the computer security 
ID (SID). 

Do not remove or insert the flash disk while it is being accessed, or if the 
operating systems has booted from it. 

Customising the Standard XPe image supplied to create a master image 
The Standard XPe image supplied on the flash disk cannot be used as a base image 
for duplication, as the image has already been sealed for production purposes. 

If you wish to customise the Standard XPe image, you must install the nonsealed 
version of the image, included on the DVD. This can be done in the same way as 
described in Reinstalling the supplied Windows XP Embedded image, page 30, using 
the image file from the nonsealed folder, instead of the sealed folder. 

This image has been created using the steps described for the duplication of Windows 
XP Embedded images (see Creating the master copy (resealing the image), page 43) 
but fbreseal has not been run. This allows you to make any customisations to the 
image before running fbreseal, and thus creating your own master image. 

 

Do not use the nonsealed image for anything other than creating a master 
image. If more than one nonsealed image is connected on the same network, 
problems will occur because they have the same SID and network name. 

For general use, use the sealed version of the image. 
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Appendix A - Contacting Eurotech Ltd 
Eurotech Ltd sales 

Eurotech Ltd’s sales team is always available to assist you in choosing the board that 
best meets your requirements. 

Eurotech Ltd 
3 Clifton Court 
Cambridge 
CB1 7BN 
UK 

Tel: +44 (0)1223 403410 
Fax: +44 (0)1223 410457 
Email: sales@eurotech-ltd.co.uk 

Comprehensive information about our products is also available at our web site: 
www.eurotech-ltd.co.uk.  

 

While Eurotech Ltd’s sales team can assist you in making your decision, the 
final choice of boards or systems is solely and wholly the responsibility of the 
buyer. Eurotech Ltd’s entire liability in respect of the boards or systems is as set 
out in Eurotech Ltd’s standard terms and conditions of sale. If you intend to 
write your own low level software, you can start with the source code on the 
disk supplied. This is example code only to illustrate use on Eurotech Ltd’s 
products. It has not been commercially tested. No warranty is made in respect 
of this code and Eurotech Ltd shall incur no liability whatsoever or howsoever 
arising from any use made of the code.  

Eurotech Ltd technical support 
Eurotech Ltd has a team of dedicated technical support engineers available to provide 
a quick response to your technical queries.  

Tel: +44 (0)1223 412428 
Fax: +44 (0)1223 410457 
Email: support@eurotech-ltd.co.uk 

Eurotech Ltd Group 
Eurotech Ltd is a subsidiary of Eurotech Group. For further details see 
www.eurotech.com 

mailto:sales@eurotech-ltd.co.uk
http://www.eurotech-ltd.co.uk/
mailto:support@eurotech-ltd.co.uk
http://www.eurotech.com/
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Appendix B - End User License Agreement (EULA) 
This Development Kit is supplied with an Evaluation Version of the Windows XP 
Embedded operating system under the terms of the Windows Embedded Kitting 
Program. The Development Kit does not include a Certificate of Authenticity (COA) 
license label, which is no longer required. The use of the Evaluation Version of 
Windows XP Embedded is subject to your acceptance of the terms of the end user 
license agreement with Microsoft. 

By using this Development Kit, you have accepted the terms set out in the End User 
License Agreement (EULA), which is on Eurotech Ltd’s Windows XP Embedded 
Development Kit DVD, in the folder Documentation \EULA. In all cases you must 
include a copy (printed or electronic) of the End User License Agreement (EULA). If 
you are not the end user, you must supply a copy of the EULA to your customer and 
make it clear that they accept the terms of the agreement. The EULA must be 
distributed along the supply chain to the end user. It is the responsibility of suppliers to 
make the terms of the EULA clear to their customer. Refer to www.microsoft.com. 

Eurotech Ltd’s GEMINI Windows XP Embedded Development Kit is supplied with a 
copy of the EULA on the Development Kit DVD. The OEM Customer License 
Agreement and End User License Agreement for the Windows XP Embedded product 
identify the application restrictions and limitations of distribution and liability.  

Windows XP Embedded Runtimes are not intended for use in all environments. 
Restricted environments include, but are not limited to, those that require fail-safe 
performance and/or those in which a malfunction of the operating system may result in 
foreseeable risk of injury or death to the operator of the device or system, or to others. 

An “Embedded Application” means industry or task-specific software programs and/or 
functionality that provide the primary functionality of the device and which offer 
significant functionality in addition to Windows XP Embedded. You must check these 
before using the product.  

http://www.microsoft.com/
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Attachment A 
COMPANY shall sublicense the Licensed Product to end users by means of a EULA. 
COMPANY shall provide clear notice to Embedded System customers before or at the 
time of purchase that the Embedded System contains software that is subject to a 
license and that customer must agree to that license before it may use the Embedded 
System. Company shall distribute the EULA in a manner that forms a contract binding 
the end user to the EULA terms under applicable law. The EULA shall contain (A) the 
following terms, and (B) any additional EULA terms set forth by MS in the Additional 
Provisions for the Licensed Product. COMPANY may include additional terms in the 
EULA, so long as they are no less protective of MS than the terms set forth below. 
COMPANY shall substitute its name for the bracketed text [COMPANY] in the EULA 
text. If permitted by COMPANY’s other software suppliers for a particular COMPANY 
Embedded System, COMPANY may substitute for the word “MS” the term 
“[COMPANY’s] software suppliers”. 

You have acquired a device (“DEVICE”) that includes software licensed by Eurotech 
Ltd from Microsoft Licensing Inc. or its affiliates (“MS”). Those installed software 
products of MS origin, as well as associated media, printed materials, and “online” or 
electronic documentation (“SOFTWARE”) are protected by international intellectual 
property laws treaties, as well as other intellectual property laws and treaties. The 
SOFTWARE is licensed, not sold. All rights reserved.  

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT (“EULA”), DO 
NOT USE THE DEVICE OR COPY THE SOFTWARE. INSTEAD, PROMPTLY 
CONTACT EUROTECH LTD FOR INSTRUCTIONS ON RETURN OF THE UNUSED 
DEVICE(S) FOR A REFUND. ANY USE OF THE SOFTWARE, INCLUDING BUT NOT 
LIMITED TO USE ON THE DEVICE, WILL CONSTITUTE YOUR AGREEMENT TO 
THIS EULA (OR RATIFICATION OF ANY PREVIOUS CONSENT). 

GRANT OF SOFTWARE LICENSE. The EULA grants you the following license:  

• You may use the SOFTWARE only on the DEVICE. 

• NOT FAULT TOLERANT. THE SOFTWARE IS NOT FAULT TOLERANT. 
EUROTECH LTD HAS INDEPENDENTLY DETERMINED HOW TO USE THE 
SOFTWARE IN THE DEVICE, AND MS HAS RELIED UPON EUROTECH LTD TO 
CONDUCT SUFFICIENT TESTING TO DETERMINE THAT THE SOFTWARE IS 
SUITABLE FOR SUCH USE.  

• NO WARRANTIES FOR THE SOFTWARE. THE SOFTWARE is provided “AS 
IS” and with all faults. THE ENTIRE RISK AS TO SATISFACTORY QUALITY, 
PERFORMANCE, ACCURACY, AND EFFORT (INCLUDING LACK OF 
NEGLIGENCE) IS WITH YOU. ALSO, THERE IS NO WARRANTY AGAINST 
INTERFERENCE WITH YOUR ENJOYMENT OF THE SOFTWARE OR AGAINST 
INFRINGEMENT. IF YOU HAVE RECEIVED ANY WARRANTIES REGARDING 
THE DEVICE OR THE SOFTWARE, THOSE WARRANTIES DO NOT ORIGINATE 
FROM, AND ARE NOT BINDING ON, MS. 



 
 GEMINI Windows XP Embedded Quickstart Appendix B - End User License Agreement (EULA) 

© 2007 Eurotech Ltd    Issue A 49 

• Note on Java Support. The SOFTWARE may contain support for programs 
written in Java. Java technology is not fault tolerant and is not designed, 
manufactured, or intended for use or resale as online control equipment in 
hazardous environments requiring fail-safe performance, such as in the operation 
of nuclear facilities, aircraft navigation or communication systems, air traffic control, 
direct life support machines, or weapons systems, in which the failure of Java 
technology could lead directly to death, personal injury, or severe physical or 
environmental damage. Sun Microsystems, Inc. has contractually obligated MS to 
make this disclaimer.  

• No Liability for Certain Damages. EXCEPT AS PROHIBITED BY LAW, MS SHALL 
HAVE NO LIABILITY FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL OR 
INCIDENTAL DAMAGES ARISING FROM OR IN CONNECTION WITH THE USE 
OR PERFORMANCE OF THE SOFTWARE. THIS LIMITATION SHALL APPLY 
EVEN IF ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE. IN NO EVENT 
SHALL MS BE LIABLE FOR ANY AMOUNT IN EXCESS OF U.S. TWO 
HUNDRED FIFTY DOLLARS (U.S.$250.00). 

• Limitations on Reverse Engineering, Decompilation, and Disassembly. You 
may not reverse engineer, decompile, or disassemble the SOFTWARE, except and 
only to the extent that such activity is expressly permitted by applicable law 
notwithstanding this limitation.  

• SOFTWARE TRANSFER ALLOWED BUT WITH RESTRICTIONS. You may 
permanently transfer rights under this EULA only as part of a permanent sale or 
transfer of the Device, and only if the recipient agrees to this EULA. If the 
SOFTWARE is an upgrade, any transfer must also include all prior versions of the 
SOFTWARE. 

• EXPORT RESTRICTIONS. You acknowledge that SOFTWARE is of US-origin. You 
agree with all international and national laws that apply to the SOFTWARE, 
including the US Export Administration Regulations, as well as end-user, end use 
and country destination restrictions issued by U.S. and other governments. For 
additional information on exporting the SOFTWARE, see www.microsoft.com.  

Microsoft OEM Customer License Agreement For Embedded Systems. 

http://www.microsoft.com/
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restarting · 26 
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symbols · 8 
system 
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target 

closing · 26 
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images, downloading · 38 

target device settings · 35 
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manual · 8 

technical support · 46 
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driver · 17 
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